


ШАБЛОНИ И ТЕКСТУРИ. 
ТЕКСТУРНА КАРТА. 

СЪЗДАВАНЕ НА ШАРКИ 
ОТ РАСТЕРНИ ИЗОБРАЖЕНИЯ. 

ИНФОГРАФИКИ 



Съдържание: 

1. Какво представляват шаблоните и текстурите? 
2. Какво е текстурна карта? 
3. Как да създадем шарка от растерно 

изображение? 
4. Изкуството на инфографиките 



Шаблони 
Шаблоните (от англ. pattern) във векторните 
изображения са фигурални мрежи с повтарящи се 
мотиви. Наричат се още шарки.  



Как да създадем шаблон 
в Adobe Illustrator? 



1. Избираме палитра 
Шарката трябва да е хармонична, затова си 
избираме подходяща цветова палитра. 



2. Създаваме квадрат и го 
запълваме с фонов цвят.  



3. Създаваме обектите, които ще 
присъстват на шарката 



4. Избираме всички обекти и даваме 
Object > Pattern > Make  



Полупрозрачни копия на 
елементите ще се 
появят около платното, 
за да ни помогнат да 
виждаме как ще 
изглежда шарката, 
когато се наложи на по-
голямо платно. 



5. Подреждаме обектите, така че да са 
разпределени добре в пространството. 



6. С двоен клик 
отвън платното 
се излиза от 
режим шаблон. 
Новата шарка се 
намира в панел 
Swatches. 



7. Готовият 
шаблон може да 
бъде приложен 
към всяка 
фигура. 
Бележка: Когато 
създавате шарки, 
внимавайте да 
балансирате добре 
композицията си. 



Текстура 

В реалния свят всеки предмет има текстура, която 
представлява покритието на всеки обект. Може да 
бъде дърво, кожа, стомана, желязо, пясък и много 
други. Като цяло думата текстура се отнася към 
повърхностните характеристики и външния вид на 
обект. Една текстура може да се опише като гладка, 
грапава, мека, твърда, матова, лъскава и т.н.т 



Природни текстури 



Създадени от човека текстури 



Текстури в триизмерното изкуство 

- Текстурата е един от основните елементи на 
триизмерното изкуство. 
- Внимателно се обмисля от скулптура. 
- Свързана е с използвания материал (мрамор, 
дърво, желязо, месинг, бронз, стомана, мазилка) и  
с процеса на създаване (леене, дърворезба, 
строителство, заваряване и др.) 
 



- Последен етап е окончателната обработка на 
повърхността – добавяне на патиниращ ефект, 
боядисване, оцветяване, избелване, лакиране, 
полиране, пастиране, шлифоване и др. 

Текстури в триизмерното изкуство 





- В някои скулпури текстурата 
създава илюзия за използване на 
различен материал от 
приложения. 
- Така авторът преразказва по-
добре своите мисли и виждания 
за сцената. 



Текстури в двуизмерното изкуство 

Ван Гог използва дебели и 
изразителни мазки, чрез 
които създава структура, 
наподобяваща вълни. 
Така картините му са не 
само интересни, но и с 
oсезаема енергия, 
придават динамичност и 
движение. 





В енциклопедиите се добавят 
текстури към двуизмерните 
рисунки, така че да се предаде 
точна информация за реалния 
обект.  



- В портретите на знатните 
особи силно се е наблягало на 
точно изобразяване на тяхното 
облекло. То е презентирало 
техния социален статус.  
- На посочена картина има 
богато разнообразие от 
текстури. Колко бихте могли 
да посочите? 





Създаване на текстура 

Когато художник създава текстура, трябва да 
създаде илюзия за повърхностни характеристики с 
помощта на цветове, линии, форми. 



Създаване на текстура в Adobe Illustrator 

Пример: 
Създаване на изображение 
имитиращо завеса. 



1. Създаваме флоралния мотив 
(шаблон, шарка) 

... 



2. Създаваме квадрат 
– основа за завесата. 



3. С Mesh Tool 
добавяме ключови 
точки отгоре и 
отдолу. 



4. Оцветяваме всяка 
ключова точка в 
различен нюанс на 
сивото. 



5. Променяме 
посоката на 
векторите, така че да 
създадем усещане за 
движение. 



6. Създаваме втори 
квадрат със зелено 
запълване под 
първоначалния. 
 
7. От Transperancy 
панела даваме режим 
„Hard Light“ - така 
създаваме прозрачност, 
но запазваме нюансите. 



8. Дублираме 
шарката, за да 
създадем по-голям 
шаблон. 



9. Поставяме шаблона 
върху завесата. 
 
10. Избираме от 
Transperancy режим 
„Overlay“ - запазва 
акцентите и сенките на 
основния цвят, като 
отразява по-светлите и 
по-тъмните тонове. 



10. Групираме всички 
елементи. 
 
11. Рисуваме един 
квадрат, който ще 
използваме, за да 
изрежем или 
„маскираме“ 
изображението, така че 
да няма шарки извън 
завесата. 



12. Премахваме 
запълването на 
квадрата. 
 
13. Object > Clipping 
Mask > Make. 





Текстурна карта 
Texture mapping е метод за добавяне на детайли, текстура 
на повърхността или цвят на компютърно генерирани 
графики или 3D модели.  
 
Текстурната карта е двуизмерна повърхност, която се 
„обвива“ около триизмерен обект. 
 
Texture mapping е електронният еквивалент на слагането 
на тапети или боя върху стените (реални 3D обекти).  
 
 









Използването на 
текстурни карти в Adobe 
Illustrator е сложен и 
многостъпков процес.  
 
Има много видео уроци в 
интернет, които може да 
следвате и изпълните с 
AI CS6 или CC. 

https://www.youtube.com/watch?v=TjHK1SHxeSM 

Текстурни карти в Illustrator 



Създаване на шарки от растерни 
изображения 

Adobe Illustrator позволява създаването на шарки от 
растерни изображение или от части на растерно 
изображение. 
 
 
 



1. Поставяме 
изображението в AI чрез 
File>Place. 
 
2. Избираме опция 
Embed, тъй като ще 
създаваме шарка, 
изображението не трябва 
да бъде linked към 
външен ресурс. 

Създаване на шарка от растерно изображение 



3. Хващаме 
изображението и го 
влачим в Swatches 
панелът отдясно или 
Object>Pattern>Make 
 
4. Новата шарка е 
готова. Сега с нея 
можем да запълним 
всеки обект. 



Създаване на шарка от част растерно изображение 

1. Поставяме 
изображението в AI 
чрез File>Place. 
 
2. Избираме опция 
Embed, тъй като ще 
създаваме шарка, 
изображението не 
трябва да бъде linked 
към външен ресурс. 



3. Хващаме 
изображението и 
избираме 
Object>Pattern>Make 
4. От панелът Pattern 
options избираме 
Pattern Tile Tool (горе 
вляво) и с него 
очертаваме само 
частта, която искаме да 
използваме за шарка. 
5. Done 



Оригинално 
изображение 

Шарка с оригиналното 
изображение 

Шарка с част от оригиналното 
изображение 



Днес информацията ни засипва отвсякъде – чрез социални 
мрежи, блогове, медии, интернет. Всички те непрекъснато се 
борят за нашия интерес, раздвояват, разтрояват го. Така 
последните проучвания показват, че за половин век 
концентрацията ни е намаляла с почти 40 пъти, а вниманието, 
което отделяме на реклами, статии и други е достигнало едва 8 
секунди... В основата на качественото насочване на 
подходящата информация към читателите ни стои визуалното 
съдържание. Така на помощ идва инфографиката.  

Инфографиката - новото направление за 
визуализация на данните 



Инфографиките (наричани още графични визуализации или 
информационни графики) са измислени с една единствена 
цел: да пресъздадат възможно най-много информация на 
читателите само с един поглед, за отрицателно време, 
оставяйки трайни спомени. С прости думи: инфографиките 
са визуализирано копие на даден обем “статична” 
информация. 

Инфографиката - новото направление за 
визуализация на данните 



Инфографиките представляват много силен начин за 
привличане на внимание към нашия продукт или данните, 
които искаме да визуализираме. Те са чудесен и мощен 
инструмент за комуникация в онлайн пространството: сайтове, 
блогове, социални мрежи.  
Инфографиката се превръща в основен фактор в 
информацията и образованието на бъдещето. 
Инфографиката е визуално представяне на информация чрез 
илюстрации, диаграми, снимки, тримерни модели, анимации и 
др. 
 

Инфографиката - новото направление за 
визуализация на данните 



Инфографиките представляват много силен начин за 
привличане на внимание към нашия продукт или данните, 
които искаме да визуализираме. Те са чудесен и мощен 
инструмент за комуникация в онлайн пространството: сайтове, 
блогове, социални мрежи.  
Инфографиката се превръща в основен фактор в 
информацията и образованието на бъдещето. 
Инфографиките са големи, цветни и богати на информация 
графики, представени чрез диаграми, графики, линии, цветове 
и други.  
 

Инфографиката - новото направление за 
визуализация на данните 





Всички сме виждали статии със свръхдълъг текст, макар и интересни, 
се отказваме от дочитането им. Целта на инфографиката е да 
резюмира дълъг и невинаги хващащ окото текст в няколко 
картинки, които, освен че са атрактивни и интересни, помагат на 
читателя да усвои информацията качествено и дълготрайно. 
Това може да бъде обяснено чисто психологически – мозъкът 
възприема много по-ефективно визуалното съдържание – до 90% от 
информацията, достигаща до него, докато от прочетения текст 
запомня едва 20%. Инфографиката, благодарение на своя свеж и 
разчупен стил, хваща окото на всеки, а близо 87% от текста по нея 
бива прочетен. 

Инфографиката - новото направление за 
визуализация на данните 



Какво се случва  със съзнанието ни, когато то трябва да приема 
информация? Всъщност всичко около нас е информация. Цветове, 
форми, размери, звуци, аромати… Мозъкът ни я преобразува така, 
че при повторна среща със същите обстоятелства, ние да я 
разпознаем. Ако трябва да разгледаме по-конкретно: какво се 
случва, когато четем даден текст? Съзнанието ни създава 
различни визуални паралели на информацията, която приемаме. 
Така то по-лесно оперира с данните и ги “складира”, за да бъдат 
съхранени и ползвани по-късно.  

Инфографиката - новото направление за 
визуализация на данните 



Затова например, докато четем инструкциите за правене на 
домашно лате, най-вероятно ще си представим съвсем реална 
ситуация, в която изпълняваме условията едно по едно. Това е 
възможно, тъй като в съзнанието ви вече съществуват “картини”, 
свързани с тази напитка. Така лесно пресъздаваме ситуация, в 
която не сме изпадали реално. Благодарение на асоциативното 
мислене е възможно да си създадем визуална представа за това 
как се прави лате, дори никога да не сме виждали процесът в 
действие. 

Инфографиката - новото направление за 
визуализация на данните 







Трикове за ефективни инфографики 







 
Съществуват различни правила за създаването на 
инфографика, която спомага за предаването на нашето 
съобщение по най-ефективния начин. Тук ще бъдат по-
важните от тях: 
Правило 1 - Планирайте своята история и цели 
Трябва да си изясним точно темата на инфографиката, която  
би трябвало да става ясна от заданието. Добре е да помислим 
върху това какво искаме да постигнем с нея - да доведем нови 
клиенти на сайта си, да съберете имейл адреси на 
потребители, да получите обратни линкове в чужди блогове 
или просто да съощим нещо важно? 

Съвети за качествена инфографика 



След като си изясните какви са целите, които 
инфографиката трябва да постигне, е ред на историята, 
която ще визуализираме по тази тема. Данните, които ще 
споделим с нея ще са толкова интересни, колкото е нашата 
история. 
На този етап е полезно да съставим план нейн план.  Би 
било полезно, ако напишете кратка интродукция за своята 
инфографика, която да предлага контекст на вашата 
история. Тя ще ви помогне да не се отклонявате от 
предварително установените си цели. 

Съвети за качествена инфографика 



 
Правило 2 – Съберете нужните коректни данни 
Най-важното в една инфографика остават цифрите и данните. 
Те придадат достоверността на това, което ще показваме и 
обясняваме.  
Можем да използваме Google, за да съберем информация за 
това какво е интересно за широката публика в този момент 
(например Google Trends или инструментите, показани на 
следващите слайдове). Самите данни можем да получим от 
различни местни бази за проучвания. Добре е да помним, че не 
е нужно да споделяме всичко от дадена тема, а само това, 
което би било интреесно на нашата публика.  

Съвети за качествена инфографика 



 
Правило 3 – Скицирайте идеята 
Преди да започнем с избора на цветове и шрифтове за 
инфографиката, първо е добре да скицираме нашата идея. 
Тук могат да ни помогнат много инструменти като Google 
Slides, Gliffy, Creatly, Visualy. 
Tрябва да уточним какво искаме нашата аудитория да види 
първоначално, когато погледне инфографиката. Добре е да 
направим йерархия на елементите в нея, което спомага при 
оформянето на цялостния образ.  

Съвети за качествена инфографика 



 
Правило 4 – Потърсете вдъхновение 
Преди да започнем дизайна на нашата инфографика е добре да 
разгледаме подобни реализации на близки теми. По този начин 
не само ще се вдъхновим, но може и да спестим допускането 
на някоя грешка.  
В нашия дизайн може да включим цитати, достоверни мнения, 
кратки факти от историята, които допълнително да задържат 
интереса между отделните графики и класации. 

Съвети за качествена инфографика 



 
Правило 5 – Създайте инфографиката 
Налични са няколко уеб-базирани приложения, които могат да  
ни помогнат като Infogr.am и Piktochart (те ни предлагат 
темплейти за създаване на таблици и графики). Ако ни трябва 
помощ при избора на размери за дадена инфографика на 
помощ идва Visual.ly, който ни предлага готова инфографика с 
пълна информация по темата. Нашата инфографика трябва да е 
достъпна, както за мобилни устройства, така и на настолни 
компютри. Освен всичко това трябва да помислим за "лекотата" 
на нашето произведение. То трябва да се зарежда бързо дори 
при ниска скорост на интернет връзката.  

Съвети за качествена инфографика 



 
Правило 6 – Проверете видимостта на инфографика в 
социалните мрежи 
Нашата инфографика трябва да е добре видима от 
потребителите в социалните мрежи. За тази цел може да 
изберем част от нея с примерни размери 250х500 пиксела 
височина и широчина. След това трябва да я споделим в 
различните си социални мрежи с линк към цялата 
инфографика на сайта ни. Така избягваме опасност от бавно 
зареждане на цялостното изображение и/или неприемливо 
изрязване на инфографиката при споделяне на директен линк 
към нея. 

Съвети за качествена инфографика 



 
Правило 7 – Споделяйте вашето произведение 
Освен в социалните мрежи, можем да помислим върху това на 
кои потребители още може да предложим нашата 
инфографика. Това трябва да са хора, които редовно пишат по 
темата, която засягаме или имат личен интерес към нея.  
Друга възможност за популяризиране е, да я качим в 
директории, които Google посещава, като например Visual.ly, 
Infographic Love, Pinterest и други. 

Съвети за качествена инфографика 



До колкото е възможно, фокусирайте се върху една идея, 
опитвайте се да давате отговор на един въпрос. Не обърквайте 
читателите с паралелни инфографики. Покажете взаимовръзките 
(ако това е целта на инфографиката) по възможно най-семплия 
начин – така, както ще се възприеме най-лесно. Направете 
инфографиката разбираема. Добрата инфографика може да 
комуникира лесно с всички хора, независимо от образованието им, 
възрастта, професията и социалния статус. Ползвайте достъпен 
език. Ако инфографиката ви съдържа твърде много термини, това 
може да обърка читателите. Старайте се всяка дума да е 
разбираема, без да е необходима справка в Google. 

Придържайте се към семпли, изчистени, дори 
стилизирани графики. 



Целта на инфографиката е да накарате хората да разберат нещо 
по-бързо и по-лесно. Не разказвайте съдържанието на 
инфографиката. Четенето отнема време! Идеята е точно обратната 
– повече информация за по-малко време. Ползвайте диаграми, 
когато ще говорите за цифри. Ползвайте картинки, когато искате 
да покажете нещо. Взаимовръзките показвайте със стрелки, 
пойнтери или други инструменти. Но не разказвайте! 

Показвайте, не разказвайте! 



Целта на инфографиката е да 
накарате хората да разберат нещо 
по-бързо и по-лесно. Не разказвайте 
съдържанието на инфографиката. 
Четенето отнема време! Идеята е 
точно обратната – повече 
информация за по-малко време. 
Ползвайте диаграми, когато ще 
говорите за цифри. Ползвайте 
картинки, когато искате да покажете 
нещо. Взаимовръзките показвайте 
със стрелки, пойнтери или други 
инструменти. Но не разказвайте! 

Показвайте, не разказвайте! 



Стълбовидните диаграми не са инфографики, макар да се 
използват в определени случаи. Това е често допускана 
грешка. Защо стълбовидните диаграми не се четат лесно на 
пръв поглед? Защото съдържат твърде много информация. И 
още нещо – асоциираме ги с Excel, което пък от своя страна 
ни напомня гигантски таблици с много, много данни, които 
ни отказват още преди да сме започнали. Затова, до колкото 
е възможно, избягвайте стълбовидните диаграми. Вместо 
това, помислете за по-креативен начин да покажете 
взаимовръзките между отделните параметри.  

Забравете стълбовидните диаграми! 



Щом говорим за изображения, уникалният дизайн е най-
важното условие, на което трябва да отговаря една 
инфографика. Най-често използваните шаблони за 
създаване на инфографики са дървовидна структура и 
концентрични кръгове. Действително това са най-удобните 
и интуитивни модели. Лесни са за проследяване и казват 
много, дори само с начина по който са подредени.  
Тук идва един друг, важен момент: създаването на 
шаблона определя до 95% до каква степен една 
инфографика ще бъде възприета.  

Да излезем от рамката 



Тоест, колкото по-ясна е последователността на елементите 
в шаблона от пръв поглед, толкова повече информация ще 
възприеме читателя, без да се стреми да следи 
взаимовръзките между отделните компоненти. Най-
впечатляващите инфографики следват съвсем друг 
алгоритъм – визуализация на всички нива. За тази цел се 
създава шаблон, който представлява графика на цялостната 
идея (мащабен модел). Така инфографиката комуникира с 
читателя първо на подсъзнателно ниво (посредством 
шаблона), а след това и на съзнателно (всички графични и 
текстови елементи). 

Да излезем от рамката 



Независимо дали сте професионален дизайнер или аматьор, 
комбинирането на цветове е в основата на ефективната инфографика. 
Трябва да се избягват съчетания от ярки цветове на едно място, като 
ярко жълто и искрящо червено. Бялото не е удачно за фон на 
инфографиката. Ако използваме изображение за фон, добре е то да 
не е много детайлно – това ще затрудни разчитането на самата 
графика. Неоновите цветове, колкото и да привличат погледа, също 
не са удачни, защото затрудняват бързото разчитане на текста. 
Повечето инфографики завършват “сляпо”, т.е. нямат ясно изразено 
начало и край. Ако информацията, която излагате чрез графика има 
направление, можете да акцентирате началото с по-светъл цвят, а 
края – с по-тъмен. Ключовата дума тук е: пробата! 

 
Цветовете – основният “информатор” в 

инфографиката 



Трябва да обясним читателя защо трябва да отдели 
време за нашата инфографика. Затова помага 
структурирането на информацията, която излагаме, 
като приказка - разказване на история. Хората 
асимилират по-добре, когато виждат взаимната връзка 
между отделните данни. Когато покажем, че нещо, има 
посока, то всички компоненти на приказката (завръзка, 
кулминация, развръзка), ще накарате хората да бъдат 
по-ангажирани към съдържанието, да искат да 
разгледат инфографиката до края. 

Инфографиката като приказка 



Винаги проверявайте информацията, която излагате в 
инфографиката. Това условие е по-важно от дизайна, 
структурата, цветовото оформление и сюжетната линия. 
Доброто съдържание е това, което прави графиката ви 
интересна и полезна на читателите. Затова не се 
доверявайте на непроверени данни. Една грешна цифра 
може да накара хората да се съмняват в правотата на 
това, което съобщавате чрез инфографиката си и така 
рискувате да ги загубите за следващи проекти, статии и 
графики, които ще изготвяте в бъдеще. 

Защо е важна проверката на данните 



Ако се питате дали има стандартни 
размери за нашата инфографика, то 

отговорът е НЕ, но съществуват 
препоръчителни. 

Размери за инфографика 



Размери за инфографика  
Ориентация 
 



 
Височина/ширина (600px-1100px  за вертикални и 1200x900 
за хоризонтален) 
 

Размери за инфографика 



Пропорция (1:4 - вертикална; 3:2 - хоризонтална) 

Размери за инфографика 



Пропорция (1:4 - вертикална; 3:2 - хоризонтална) 

Размери за инфографика 



Пропорция (1:4 - вертикална; 3:2 - хоризонтална) 

Размери за инфографика 



Всеки инфографичен проект трябва да започва със събиране 
на „суровите“ данни. За това помагат ключови въпроси като: 
"Какво се опитвам да обясня? Какво се опитвам да покажа? 
Каква е основната идея? 
След като вече сме събрали данните, следва фазата на 
обработка и разпределяне на информацията. Често се отсяват 
и премахват 80 до 90 процента от суровите данни, докато се 
стигне до истинската история. От голямо значение е винаги 
да цитираме точно източниците си. 

Започнете с данните, а не с визията! 



Качество на данните – в нашия век информацията е стока, 
колкото повече и по-качествена е тя, толкова по-добре. След 
като вече сме избрали историята, която искаме да разкажем, 
е добре да съберем достатъчно пълна и полезна информация 
по темата. Тя ще ни бъде необходима, за да подкрепим 
тезата си. Основните методи за събиране на необходимата 
информация са два – чрез използване на авторитетни 
източници или от хората в екипа. Отново: винаги посочвайте 
източниците си на информация! 
  

Започнете с данните, а не с визията! 



Да разкажем историята чрез визуализация на данните в 
инфографики е изключително важно. Ако няма добра 
история, не е интересно. Една обикновена графика със 
сурови данни не би била полезна на никого. Историята е 
това, което ще ни отличи сред множеството инфографики. 
Ако те са креативни и забавни, то хората ще я запомнят. 

Историята е важна! 



Историята – това е най-важният елемент от всяка една 
инфографика, тя трябва да разказва история на читателите. 
Тази история не е за нас или за нашия продукт, а за 
читателите, само така те ще споделят и разпространяват 
творбата ни. Трябва да разберем от какво се интересуват 
читателите ни, какво коментират във форумите и какво 
споделят в мрежата. Един добър подход при подбора на идея 
е да вземем твърдение, с което доста хора няма да се 
съгласят. След това използвайки цялата налична информация 
да “разсъждаваме” около него чрез обосновани твърдения.. 

Историята е важна! 



Историята е важна! 



Историята е важна! 



Трябва да имаме предвид три неща, когато създаваме 
инфографики: 
 
• Те трябва да са привлекателни - нашата аудитория трябва 

да поиска да ги разгледа. 
• Те трябва да имат смисъл - нашите потребители трябва да 

разберат това, което виждат. 
• Те трябва да са запомнящи се - нашите потребители трябва 

да останат ангажиранани с информацията, която сме 
споделили. 

Трите основи на инфографичния дизайн 



Това, което прави една инфографика различна от другите, са 
малките „допълнения“, които добавят добрите дизайнери. Те 
често използват изометрични ъгли, накланяне или 3D 
елементи от дизайна. Ако сме добри с 3D проектирането, то 
може да се превърне в наша визитна картичка. 

Силата на уникалните визуални щрихи 



Инфографиката е история, която трябва да се развива по 
естествен начин. Подобно на една приказка, тя трябва да се 
разказва последователно и логично. В процеса на подготовка 
може да съберем купища данни, много от тях вероятно няма 
да бъдат интересни за читателите. Постарайте се да пресеете 
само това, което носи някаква смислена и полезна 
информация и игнорирайте всичко останало. Ако се опитаме 
да представим цялата информация, читателите ще загубят 
фокус и няма да могат да се концентрират върху историята. 

Оформление 



Ако инфографиките не са моментно увлечение за нас и 
искаме да градиме наша марка в областта, то трябва да 
добавим необходимите за това елементи във футъра – 
лого и име на компанията, както и адрес на уеб 
страница или друга важна информация. Това ще води 
трафик към нашата страница след като инфографиката е 
готова. 

Брандиране 



Инфографиките са форма на изкуство, но все още в начален 
стадий. Следващият етап в еволюцията им ще се фокусира 
върху интерактивността. С развитието на интерактивните 
технологии, на material design (Google), ние ще можем да си 
взаимодействаме с инфографиките по един нов начин, а в по-
далечно бъдеще холограмите значително ще променят начина, 
по който ги виждаме днес. Така те ще започнат да ангажират 
все повече хора и ще обхванат много широк спектър от сфери. 

Бъдещето на инфографиките 



Инфографиките са повече от един модерен начин за 
визуализиране на данните. Те променят начина, по който се 
разказваме нашите истории. Ако искаме да подобрим работата 
си, то е време да започнем да ги използваме. 
 
Опитайте се да бъдете новатори и вложете нещо от себе си. 
Много скоро ще разберете, че усилието си е заслужавало. 

Бъдещето на инфографиките 







1. Добавяне на интерактивни функции към графиките 
2. Използвайте видео и Анимация 
3. Предвидете дизайн и за таблетите 
4. Използвайте качествени данни, за да предвижвате проекта 
5. Създавайте инфографики за Market Research 
6. Използвайте инфографики, за да преодолейте езиковите и 
културни различия  
7. Инфографики за презентациите 
8. Направете план, проверете го поне два пъти 
9. Спазвайте правилото за малък размер на файла 
 

10 тенденции в инфографиките 



На много от нас често ни се налага да показваме данни, 
постигаме цели, проучвания, очаквания и реални резултати. 
Искаме данните да се разберaт от всички колеги, дори и от 
другите отдели. Искаме данните да постигнат търсения ефект и 
да впечатлят, а не да стряскат хората. В някои ситуации казусът 
няма голямо развитие във времето, но линеарен чарт ли 
използваме или със стълбчета. Винаги ли е подходящ пай 
чартът? Как го преценяваме? 

Какъв вид графика да използвам за данни? 



На много от нас често ни се налага да показваме данни, 
постигаме цели, проучвания, очаквания и реални резултати. 
Искаме данните да се разберaт от всички колеги, дори и от 
другите отдели. Искаме данните да постигнат търсения ефект и 
да впечатлят, а не да стряскат хората. В някои ситуации казусът 
няма голямо развитие във времето, но линеарен чарт ли 
използваме или със стълбчеста диаграма. Винаги ли е подходящ 
пай чартът? Как го преценяваме? 

Какъв вид графика да използвам за данни? 



Те са по-добрия избор, когато 
искаме да проследите 
развитието на промените в 
кратък или дълъг период от 
време.  
По-подходящи са от Bar Chart, 
когато има малки промени в 
развитието, защото могат да 
сравняват едновременно 
повече от една група за един и 
същ период. 

Line Graph 



Използвайте бар чартовете, 
когато искате да сравните 
две или повече групи в един 
и същи момент или в отделни 
последователни моменти.  
 
Ефектът е по-силен при по-
голяма разлика в данните. 

Bar Chart 



С него сравнявайте части от 
едно цяло. Особеното е, че тук 
няма промяна във времето. 

Pie Chart 



Този вид графика много 
прилича на Line graph. Отново 
проследяват промените в една 
или повече групи през 
определен период. Тук по-
полезното е, че много ясно 
визуално се открояват 
разликите. 

Area Graph 



X и Y ни помагат да отразим 
връзките между две 
различни неща. 
Едновременно с това 
отделните моменти, в които 
се срещат, могат да бъдат 
сравнени помежду си и да се 
отделят в различни групи, 
както е на графиката. 
Трите цвята точки отделят 
три групи. 

X-Y Plot 



По статията на  Кристин Ликаса on October 14, 2014 

Пример 

Тема: прогноза за демографското развитие на страната ни до 2030 
г. Според нея населението на България дотогава ще е 3,5 млн. 
души, като по-малко от половината ще са от български етнос. 

http://makethem.net/author/krisi/


Пример – недостатъци на табличния подход 

1. Сбита информация 
2. Липсата на графични елементи или цвят (като изключим удебелените 
числа в последната колона). Това може да откаже огромна част от 
читателите дори да се опитат да я проумеят. 
3. Неясно форматиране на лявата колона – имената на едните държави са 
вляво, другите в средата, а третите леко вдясно, тоест няма и коректно 
подравняване. 
4. Всички данни вдясно са подсилени, въпреки че някои от тях са 
негативни, а други позитивни – така контрастът между едните и другите се 
загубва.  
Трябваше да се подчертаят или едните, или другите – в единия случай 
щеше да е наблегнато на факта, че едните са с негативен прираст, а в 
другия – да се подчерае положителния прираст на другите.  



Пример – редизайн 

Етап 1 
 
Какъв вид е информацията? 
 
Не е абстрактна концепция или йерархия, а представяне на данни, 
но без координатна система. 
 
Затова подходящо би било да се визуализира с ленти, които да 
позволят на читателя по-лесно да сравни броя на жителите в 
различните държави. 



Пример – редизайн 

Етап 2 
 
Какви цветове да се използват и как? 
 
Целта е да се информира и цветовете трябва да са по-неутрални, 
но все пак трябва да има контраст, който да привлича вниманието 
върху най-важното от данните. 
 
Избор: основен цвят син, с вторични цветове - неговите нюанси и 
жълтото като контрастен. 



Пример – редизайн 

Етап 2 
 
Какви цветове да се използват и как? 
 



Пример – редизайн 

Етап 3 
 
Подредба и степенуват на елементите, изграждане на 
йерархия 
 
• Смяна на заглавието за по-голяма краткост и яснота, както и 

промяна на буквите с по-големи от същия шрифт и удебелени. 
• Допълнителните текстове като източници и пояснение са с най-

малък шрифт, но не прекалено, за да се виждат и от седящите 
най-отзад, ако инфографиката се използва в презентация. 

• Подравняване на всички елементи. 



Пример – резултат 



Пример – редизайн 



Полезни инструменти за 
Инфографика (Infographics) 

Инфографиката е един от най-разпространените в момента 
тенденции за създаване на атрактивно съдържание. 
Тя пресъздава информацията ясно и е лесна за четене. 
Източници и инструменти за създаване на инфографики: 
http://visual.ly // източник 
Infogr.am // инструмент 

http://piktochart.com/ // инструмент 
http://www.easel.ly // инструмент 
https://cacoo.com/diagrams/  // инструмент 

 

  
 

http://visual.ly/
http://piktochart.com/
http://www.easel.ly/
https://cacoo.com/diagrams/


Полезни инструменти за 
Инфографика (Infographics) 

Hohli Builder // инструмент 
https://developers.google.com/chart/ // инструмент 
http://vizualize.me/  // превръща LinkedIn CV в инфографика 
http://www.easel.ly // инструмент 

http://www.google.com/publicdata/directory // инструмент 
http://www.wordle.net/create // малко стара, но ефективна услуга за 
създаване на mind mapping, въз основа на някакъв текст. 

https://slemma.com/infographics  
http://visage.co/  
 

 
  
 

http://charts.hohli.com/cht=p3&chs=320x240&chd=s:&chf=bg,s,FFFFFF|c,s,FFFFFF&max=100&agent=hohli.com
https://developers.google.com/chart/
http://vizualize.me/
http://www.easel.ly/
http://www.google.com/publicdata/directory
http://www.wordle.net/create
https://slemma.com/infographics
http://visage.co/


* Част от материалите в тази лекция 
са изготвени съвместно с 

доктор Маргарита Атанасова 
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Източници 
Съдържание на темата: http://www-it.fmi.uni-
sofia.bg/ReDisInfo/courses/modules/module4/parts/module4/part7/index.html 
За текстури: https://www.cs.auckland.ac.nz/~georgy/research/texture/thesis-
html/node5.html 
Урок за създаване на шарка: http://design.tutsplus.com/tutorials/create-a-cute-
winter-seamless-pattern-in-adobe-illustrator--vector-19474  
Създаване на шарки от растерни изображения: 
http://www.designeasy.co/2012/07/creating-patterns-from-bitmap-images-in.html 
http://infographicsgroup.com/good-infographics-elements/ 
http://raz.bg/blog/infografika-online-magazin/ 
http://bgsmart.com 
http://present-it.net/vizualizirai-informaciata-7-syveta-za-syzdavane-na-infografika/ 
http://infographicsgroup.com/good-infographics-elements/ 
http://hicomm.bg/polezno/infografikite-nujdaem-li-se-ot-tjah-i-kak-da-gi-napravim-
po-dobri.html 
http://anna.vc/post/112863438962/how-to-think-using-visual-analogies 



Източници 
http://www.benjamintravis.com/5-facts-standard-infographic-dimensions/ 
http://makethem.net/2014/10/14/a-more-interesting-infographic-design/ 
http://makethem.net/wp-content/uploads/2015/10/infographic_08_2016.jpg 
http://makethem.net/2015/10/16/how-to-choose-which-type-of-graph-to-use/ 
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